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Introduction F-s

Free-Flow
An innovative in-built utility that allows the unit
to automatically switch between channels by

INTRODUCTION monitoring the mouse pointer position.
The CCS-PRO* series of switches are focussed upon allowing you to
seamlessly access multiple computers and their display screens, using common
peripherals.

CCS-PRO switches allow you to use a single USB keyboard and USB mouse
to fulfil functions that previously required four or eight separate sets. This
provides immediate savings in both desk space and also the time required to
access and control systems and screens. The CCS-PRO4 supports up to four
connected systems while the larger CCS-PROS8 allows up to eight systems to
be accessed.

INSTALLATION

CCS-PRO switches feature our True Emulation technology, which ensures that
the full characteristics of the connected USB keyboard and mouse are passed
to every system.

CONFIGURATION

In addition to switching the keyboard and mouse, the CCS-PRO switches can
also share a set of speakers and two separate USB peripherals between the
various systems.This can be done either in concert with the keyboard and
mouse (and each other) or totally independently.

CCS-PRO switches can be used in combination with various Adder extender
products (such as AdderLink Infinity, X50 and X-DVIPRO) to extend the
distance between the user and the computers under control.

OPERATION

Switching between the systems connected to the CCS-PRO switches can be
achieved in six different ways:

* The innovative Free-Flow automatic switching utility,
* The COMPUTER button on the front panel,

* Keyboard hotkey combinations,

FURTHER
INFORMATION

¢ Mouse button combinations,

The keyboard/mouse, the speakers and two individual
) USB channels can be collectively or separately 5 Internal
* The optional remote control selector. switched through to each PC system using a variety network

.. . . . of manual and/or automatic switching methods.
Where additional feedback is required as to which systems and screens are -

| d ny time, th ional -XB kit provides discr ick-on LED
€ ec.te .at a y time, the optiona CCs . t provides discreet st C. © The CCS-PROS8 is depicted here with its maximum
monitor indicators.When a system/screen is selected, a corresponding LED of eight computers and screen. CCS-PRO4 models
monitor indicator illuminates (in a choice of colours) to confirm the action. support up to four computers and screens.

* Remote control via an external system,

INDEX

The optional USB Clipboard application can be used to allow text to be Remore
configuration

copied and pasted between any of the connected systems.A special utility and control
program (and Microsoft .NET v4.0 or above) must be pre-installed on each — =
—

. - * References to CCS-PRO apply equally to both
computer that requires use of the cut and paste facility. the CCS-PRO4 and CCS-PRO8 products. <




WHAT IS FREE-FLOW?

Adder Free-Flow delivers an innovation in K/M switching. Using Free-Flow you can
automatically switch between target computers simply by moving the mouse pointer
from screen to screen.

Adder Free-Flow resides on the CCS-PRO switch itself, sensing screen boundaries and
instantaneously switching keyboard and mouse (and related peripherals) to the defined
target computer. Free-Flow can be configured for almost any combination of screens,
which allows you to declare the individual screen sizes and visually position each one
relative to the others.

Free-Flow consists of special code within the CCS-PRO switch plus an intuitive graphical
configuration application. First you inform the Free-Flow configuration application how
many screens you have, their pixel resolutions and how they are physically arranged (e.g
side-by-side, vertical stack, square formation, etc.).You then download this information to
the CCS-PRO switch and this is used during operation to determine the precise moment
to switch from one screen/system to the next.

The beauty of Free-Flow is its simplicity of configuration and operation. Once the initial
configuration has taken place, all monitoring and switching is handled within the CCS-
PRO without need for extra connections or software utilities.

Issues when using Free-Flow

* When computers and their displays are not currently selected, the CCS-PRO ‘parks’
their mouse pointers in the bottom right corner of the screen. In most cases this will
cause no issues, however, it may be noticeable in circumstances such as the following:

* If the task bar is set to auto hide and it is positioned either along the bottom of the
screen (as default) or along the right hand side, then the task bar will automatically
reappear when the mouse pointer is parked.

* When playing full screen video, the on-screen controls (play, pause, seek etc.) will
very likely be revealed when the mouse pointer is parked.

* To cure the either of the above issues, it is possible to alter the mouse parking
position.

* The mouse will not flow across the screens while any mouse buttons are pressed

down - this prevents undesired behaviour when dragging windows around or group-
selecting items.

* Free-Flow is not supported on Linux operating system.

* Multi-Monitor Free-Flow is for use with the Windows operating system only and
requires specialist driver to be installed on each PC. See Multi-Monitor Free-Flow
configuration for details.

More information

* Free-Flow configuration

* Multi-Monitor Free-Flow configuration
* Operation: Selecting a computer

As you move the mouse
between screens, Free-Flow
works in the background
to switch the keyboard and
mouse to the corresponding

computer.
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CCS-PRO4 FEATURES

The unit is contained within a slimline metal casing that measures just 290 x 128 x 3 Imm.

COMPUTER K/M SPK USBI USB2

“ e 6 0 o
| ADDER

www.adder.com

COMPUTER button Indicators MODE button

Press to change to the The upper four indicators (K/M, SPK, USB |, USB2) show which peripherals are switched to Press to determine which

next computer channel. the current computer channel OR (as you begin pressing the MODE button) the peripherals peripherals should be
that will be switched during the next press(es) of the COMPUTER button. switched to another

computer channel

The lower four indicators scroll across in sequence when the Free-Flow utility is engaged. -
(will occur when the

The seven segment numeric display indicates the computer channel that is currently active. COMPUTER button is
pressed.
Options port Network port
IMPORTANT: Do not connect the OPTIONS port to any network. Can be used to remotely configure the

CCS-PRO4 and/or control switching from
an external source, such as a Crestron™,
AMX™ or similar controller (see

Switching control via the network port
* LED monitor indicators - the optional CCS-XB module links to here and provides multiple for details).
light up monitor indicators.

This 10p10c port can separately support the following functions:

* Remote control - allows channel switching either using an optional Adder RC4 four button
remote control unit (see Optional RC4 remote control) or a computer with serial port.

253 DO NOT CONNECT|
TO NETWORK!

e = - 4 3 2
CEQQE 02 0|8 o

ormens | et ) || = ) || = SWITCHED

-1 I | I

INDOOR USE ONLY

Dual power inputs User console Computer channels Switched USB ports Micro USB port
In order to provide redundancy Connect a USB Connect a USB port (vl.I or 2.0) Optionally connect up to Reserved for future use.
keyboard and mouse and (optionally) an audio output two USB devices to these
plus optional speakers from each computer to each of connectors.These ports are
to these connectors. these four channels. switched in an enumerated
(see What is True manner.
Emulation?).
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CCS-PRO8 FEATURES

The unit is contained within a slimline metal casing that measures just 433 x 158 x 3Imm. ADDER
4
¢
<

COMPUTER K/M SPK USBI USB2 <—('
COMMAND [N () eo oo 7
CCS-PROS8 = ADDER -
www.adder.com
COMPUTER button Indicators MODE button -
Press to change to the The upper four indicators (K/M, SPK, USB |, USB2) show which peripherals are switched to Press to determine which o
next computer channel. the current computer channel OR (as you begin pressing the MODE button) the peripherals peripherals should be E
that will be switched during the next press(es) of the COMPUTER button. switched to another 8
The lower four indicators scroll across in sequence when the Free-Flow utility is engaged. computer channel z
T i< display indi h h | that i | . (will occur when the o
e seven segment numeric display indicates the computer channel that is currently active. COMPUTER button is O
pressed.
Options port Network port z
IMPORTANT: Do not connect the OPTIONS port to any network. Can be used to remotely configure the 8
This 10p10c port can separately support the following functions: CCS-PRO8 and/or control switching from é
o . K ) ) an external source, such as a Crestron™, o
* Remote control - allows channel switching either using an optional Adder RC8 eight button T o (@)
) | . : AMXT™ or similar controller (see
remote control unit (see Optional RC4 remote control) or a computer with serial port. L )
Switching control via the network port
* LED monitor indicators - the optional CCS-XB module links to here and provides multiple for details).
light up monitor indicators.
Z
5
i s
<
2
Z
v = PRt
CONSOLE
S = -
_I_ X
w
o
Dual power inputs User console Computer channels Switched USB ports Micro USB Z
In order to provide Connect a USB Connect a USB port (vl.I or 2.0) Optionally connect up to port
redundancy  keyboard and mouse and (optionally) an audio output two USB devices to these Reserved for
plus optional speakers from each computer to each of connectors. These ports are future use.
to these connectors. these eight channels. switched in an enumerated
(see What is True manner.
Emulation?).



SUPPLIED ITEMS

Adder CCS-PRO4

Power adapter with locking
\\)—J connector and country-
specific power cord

Adder CCS-PRO8

Information wallet
containing:

Four self-adhesive rubber feet

Safety document
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OPTIONAL EXTRAS

ADDER
e 2
CCS-XB and CCS-XB8 LED monitor indicator kits
Kits are available for both switch models - the only difference between the two
kits are the numbers of LED indicators supplied within the kit: 4 or 8. 5
g
—
<
5
USB cable 2m (type A to B) Audio cable 2m (3.5mm stereo jacks) zZ
Part number:VSC24 Part number:VSC22 -
LED monitor indicator x 4
(or x 8)
Part number (each): CCS-LED
4
©)
g
-4
=)
9
[T
p4
o]
9]
Standard 3m CATS5 patch lead RC4 remote control CATx link cable
Part number:VSC23 plus standard 3m patch lead Four self-adhesive Part number:VSC46
Part number: RC4-8P8C rubber feet
. J/ Z
@)
g
o
i
o
(0]
Z
Serial cabl o ,9
erial cable
Part number:VSC40 E <Z(
4
RC8 remote control E 9
plus standard 3m patch lead &‘ Zz
Part number: RC8 \\(4
Q @? Additional power adapter
with locking connector
\—) Part number: PSU-IEC-12VDC-1.5A
\_J Country-specific power cords
CAB-IEC-AUS  (Austrailia)
CAB-IEC-EURO  (Central Europe) X
CAB-IEC-UK  (United Kingdom) H
CAB-IEC-USA  (United States) zZ

CCS-PRO4 rack mount brackets CCS-PROS8 rack mount brackets
plus four screws plus four screws
Part number: RMK9 Part number: RMK |



Installation

LOCATIONS
Please consider the following important points when planning the position of the CCS-
PRO switch:

* Situate the CCS-PRO switch close to the systems to which it will be connected and
near to a source of mains power.

* Thanks to Free-Flow, (and/or the optional remote control) the CCS-PRO switch can
be situated out of sight within the cabling cradle of a desk, standard rack mount or
placed adjacent to the connected systems.

» Consult the precautions listed within the Safety information section.

MOUNTING

Before you begin connecting to the keyboard, mouse and source systems, it is advisable
to mount the CCS-PRO switch in place, either:

* On a horizontal surface using the supplied self adhesive feet,
* Inastandard 19” rack mount (using optional brackets), or

* Amongst the cabling at the rear of the desk.

ADDER’
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CONNECTIONS

Connections do not need to be carried out in the order given within this guide, however,
where possible connect the power in as a final step

ADDER

User console
The ports that make up the user console are where you attach the peripherals which

z
will be shared between the computer systems. Ensure that power is disconnected from f—_’
the switch. é
To connect peripherals to the user console E
| Position your peripheral devices in the vicinity of the switch such that their cables will 4 Audio:Where required, connect the lead from your 2
easily reach. speakers to the audio socket.
2 Keyboard and mouse: Attach the leads from your USB keyboard
and mouse to the USB sockets specifically labelled with Support for optical S/PDIF audio z
keyboard and mouse symbols.The keyboard and mouse The Line In sockets on the computer ports and g
will operate in any of the USB sockets, however, True_ the Line Out socket on the user console are 5
Emulation is not available on sockets labeled USBI dual purpose.They can accept either 3.5mm %
or USB2. analog jacks or mini- TOSLINK optical fiber S
connectors.The latter provide access to the
optical S/PDIF (Sony/Philips Digital InterFace)
capabilities supported by the AdderView CCS-
PRO system, which switches PCM (Pulse Code From speakers .
From USB keyboard and mouse Modulation) audio at 96KHz. o
<
&
S
3 USB devices:Where required, attach the leads from your USB
peripherals to the USB sockets labeled USB| and USB2. 7 >
0
29
Z
From USB peripherals
i
2



Computer systems
Each computer system is connected to the CCS-PRO switch using (up to) two cables.

* CCS-PRO switches support USB 2.0 (incl. USB 1.I) connections.

To connect a computer system
| Ensure that power is disconnected from the CCS-PRO4 switch and the system to be
connected.

2 Use a USB cable (type-A to type-B) to link a USB port on the computer system to the
USB port of the required channel on the rear of the switch.

3 If required, use a stereo audio link cable (3.5mm jacks at either end) to link the
speaker port on the computer system to the audio port of the required channel on
the rear of the switch.

USB and audio links
from a system

ADDER’
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Power connections

The CCS-PRO switch is supplied with a single power adapter but offers the facility to IMPORTANT: Please read and adhere to the electrical safety information ADDER
use a second input in order to provide operational redundancy.The CCS-PRO unit can given within the Safety information section of this guide. In particular, do not use
operate perfectly well from a single power adapter operating alone.VWhen two adapters an unearthed power socket or extension cable.
are connected, the unit will spread its load between them; should one power input fail, Note: Both the switch and its power supplies generate heat when in operation and will become
5 . . )
100% of the load will be transferred to the other power adapter without a break in warm to the touch. Do not enclose them or place them in locations where air cannot circulate z
operation. Remote checking of the power inputs is possible at any time via the browser to cool the equipment. Do not operate the equipment in ambient temperatures exceeding =
interface - see Status page for details. 40 degrees Centigrade. Do not place the products in contact with equibment whose surface é
There is no on/off switch on the CCS-PRO unit, so operation begins as soon as power is temperature exceeds 40 degrees Centigrade. E
. . 9
applied at either port. Input 2 4
To connect the power supply : :
| Attach the output connector of the supplied power nput
adapter to either of the two power input sockets -
on the left side of the rear panel. Q
<
-4
To disconnect a power adapter 3
| Isolate the power adapter from the mains supply. %
Note: If you are replacing one of dual power adapters during operation, it is not necessary to v
also remove power from the other adapter.
2 Grasp the outer body of the power adapter plug where it connects with the CCS-
PRO unit. .
3 Gently pull the body of the outer plug away from the switch.As the body of the plug o
slides back, it will release from the socket and you can fully withdraw the whole plug. é
S
Note:The outer sleeve of each power connector will retract slightly as it locks into place.
2 Connect the IEC connector of the supplied country-specific power cord to the socket
of the power adapter.
z
QO
TX
z
i
a
Z

3 Connect the power cord to a nearby main supply socket.

4 Where power redundancy is required, repeat steps | to 3 for a second power adapter.



Optional remote control

The optional RC4 and RC8 remote control units (part numbers: RC4-8P8C and RCS,
respectively) can be used to provide direct push button access to any channel from your
desktop. Both remote controls are supplied with 3 meter cables that are used to link
with the OPTIONS port on the rear panel of the switches.

IMPORTANT: Do not connect the OPTIONS port to any network.
To connect the remote control

I Connect either end of the supplied cable to the socket at the rear of the RC4/RC8
remote control.

RC8 remote

RC4 remote

2 Connect the other end of the cable to the OPTIONS
port on the rear panel of the switch.

IMPORTANT: Do not
connect the OPTIONS
port to any network.

Using a remote control with the optional CCS-XB module

When the optional CCS-XB LED monitor indicator module is used with the CCS-PRO
switch, it requires permanent use of the latter’s OPTIONS port which would otherwise
be used to attach the RC4 remote.

However, the CCS-XB module has an output port that provides a link through to the
OPTIONS port (to which it is connected) that can be used to attach the RC4 remote.

To connect the remote control to the CCS-XB module
| Use the Adder Free-Flow utility to program the CCS-PRO switch (see the section
Configuring LED monitor indicators).

2 Use the patch cable supplied with the RC4/8 kit to link the remote control to the TO
KEYPAD OR PC port of the CCS-XB module.

The remote control can now be used in the usual manner to select the required
channels.

Patch cable
Adder P/N:VSC23
(Included in RC4-8P8C kit)

ADDER
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Optional LED monitor indicator connections
The optional CCS-XB module enables you to add LED (Light Emitting Diode) monitor
indicators to each of your video display screens to show which are active.

The CCS-XB module connects to the OPTIONS port of the main CCS-PRO switch. Each
individual LED monitor indicator then connects to one of the ten ports on the CCS-XB

module.

To connect the CCS-XB module and monitor indicators
I Remove power from the switch. Use the flat cable supplied with the CCS-XB kit to
link the module to the OPTIONS port of the CCS-PRO switch.

Note: If an optional RC4 or RC8 remote control is connected to the Options port, remove this

first. It can be attached to the CCS-XB module later (see here).

Adder CCS-PRO
switch

Adder CCS-XB
module

Link cable
Adder P/N:VSC46
(Included in CCS-XB kit)

IMPORTANT: Do not
connect the OPTIONS
port to any network.

2 Link each LED monitor indicator to a port on the CCS-XB
module - ports | to 4 are most commonly used.

Insert the lead for
the first indicator
into port |

LED monitor indicator with Port 4

3 meter lead

Each indicator has an adhesive pad to

-——— assist with mounting on your video
displays.

3 You need to tell the CCS-PRO which LED monitor indicator to illuminate (and in
which colour) for each channel.To do this connect your computer to the CCS-PRO
switch via a network connection and use the Free-Flow application. Please see the
section Configuring LED monitor indicators.

4 Apply power to the switch.

ADDER
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Switching control via the network port
The network port allows switching to be controlled by commands issued from an
external system such as a Crestron™ or AMX™ controller.

Connecting to a network for remote control
| Use a standard patch cable to link the network port (EIEIE) of the CCS-PRO unit to a
network switch.

Link from
network
switch

2 Ensure that the CCS-PRO network port is correctly configured to a subnet that is
accessible from the sending device. See Network settings for details.

Issuing remote switching commands via the network port
The Application Programming Interface (API) for the CCS-PRO requires the controlling
system to send an HTTP Get request to the following location:

* <ipaddress>/cgi-bin/channel

The following parameters are available:

* km=<channel> Switches the keyboard and mouse to the defined channel.
¢ spk=<channel> Switches the speakers to the defined channel.

e usbl=<channel> Switches USB port | to the defined channel.

* usb2=<channel> Switches USB port 2 to the defined channel.

An example string is: 192.168.1.22/cgi-bin/channel?km=3 &spk=48&usb | =2 &usb2=1
The above example would switch the keyboard and mouse to channel 3, the speakers to

channel 4, USB port | to channel 2 and USB port 2 to channel |.

Note: If security is enabled then the client must be authenticated before you are able to access
the CCS-PRO.

ADDER’
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Switching control via the Options port

The OPTIONS port allows an external serial input, typically from a computer, to control
the selection of the various channels.You can use either an optional serial cable (part
number VSC40) or alternatively construct a custom cable to link the CCS-PRO switch
and the computer. For pin-out details of the custom cable, see Appendix 1.

ADDER’

Upon receipt of the correct code, the CCS-PRO will switch immediately to the z
appropriate channel. g
-
Connecting a computer for remote control Serial port parameter settings E
The cable link from the computer needs to connect the transmit (TXD) line of the Ensure that the chosen serial port is configured to the following: 2
computer to the receive (RXD) input of the CCS-PRO and also link the ground  Baud rate: 1200
terminals (GND) of the two devices. See Appendix | for details. « Data bits: 8
To connect a computer remote control « Stop bit: I _
I Use an optional serial cable to link the OPTIONS port on the rear panel of the CCS- Parity: 0
. . * Parity: None =
PRO switch and a vacant serial port on the computer. %
0
Channel selection codes g
IMPORTANT: Do not ASCII ©
connect the OPTIONS Character Hex Decimal
port to any network. * Channel I: ‘r 0x31 49
* Channel 2: 2 0x32 50 .
* Channel 3: ‘3 0x33 51 g
e Channel 4: ‘4 0x34 52 &
o
* Channel 5: ‘5’ 0x35 53
¢ Chamnel 6 036 34 cCs.PRO8 models only
* Channel 7: 7 0x37 55
Note: If the optional CCS-XB module is used with the CCS-PRO, connect the computer instead * Channel 8: ‘8 0x38 56 z
to the TO KEYPAD OR PC port on the CCS-XB module. & =
E2
20
z
i
a
Z



Configuration &

INITIAL CONFIGURATION

The configuration, monitoring and management of the CCS-PRO unit is performed using z
the in-built Adder CCS Manager utility which is accessible via the network connection g
using a standard web browser. 3
5
Z
Accessing the CCS Manager
To access the CCS Manager
| Use a computer that is directly or indirectly (i.e. via a network switch) connected to - ~
the CCS-PRO unit. If you need to make a temporary connection, see right o To temporarily connect a computer to the network port 3
2 Run a web browser on your computer and enter the IP address of the CCS-PRO.The | If you need to make a temporary connection for configuration purposes, use a g
default setting is: 192.168.1.22 standard patch cable (cross-over or straight connections are both supported) 5
to link the Ethernet 10/100 network port () of the CCS-PRO unit to your 2
3 If requested, enter your username and password to log on. i 5
. ) ) computer’s network port. o
Note:The default username and password are ‘admin’ and ‘password’ respectively. Y
The opening page of the CCS Manager should be displayed:
CCS-PRO z
6 March 20 g
=4
a
o}
CONFIGURATION
UPGRADE
Temporary link from o 5
your computer 2
|\ ) EX
-4
29
P
Note: If the CCS-PRO has been previously configured and those settings are unknown, see the «
Troubleshooting section for details about reverting to the default settings. é

Logging out
There is no log out option.You merely need to close the browser that you are using to
access the CCS Manager.



Status page

The Status page provides details about the dual power inputs, the internal operating Channel control ADDER
temperature and also allows you to switch peripheral channels. The Channel control section shows the computers to which each of the user console
To display the Status page peripheral channels are switched.You can use these entries to individually switch each
| Access the CCS Manager. peripheral to any of the computers.
2 The Status page is the first to be displayed, however, if necessary, click the Status To switch peripherals between channels z
button shown on the left side:The page will be displayed: I Access the CCS Manager. E
2 If necessary, on the left side, click the Status button. 'f_(
CCS-PRO 4 3 In the Channel control section, click the numeric field to Z

rch 2017 the right of the required peripheral channel, (e.g. KM channel,
speaker channel, etc.) to reveal a drop down list.

4 Click the number of the computer to which the peripheral

Zz

should be switched. The CCS-PRO front panel display will o

. . =

CONFIGURATION respond when peripheral channels are switched: g

. .. . 2

SRR annel 1 * The main seven digit number shows the computer to which 0

channel |14 .

ar:: 1: the KM (Keyboard and Mouse) channel is connected. z

nei ook o

annci el ¢ If any of the other channels are switched to a different channel than the KM, their v

respective indicators will flash.

Temperature/ : 30 °C %

=

MAC address g

a

(¢}
Click here to Provides power Indicates to which computer -
choose the input and internal channels the various user console o 8
required page. temperature details as peripherals are currently connected. I <Z(
well as the unit’s fixed You can click these to switch any % <
MAC address. peripheral to another channel. - =

X

w
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General configuration
The General configuration page contains various switching and identification options.

To display the General configuration page
| Access the CCS Manager.

2 On the left side, click the Configuration button.

ADDER

STATUS

UPGRADE

Basic options
Within the General configuration page you can adjust various Basic options:

* Hotkeys - CCS-PRO switches use (ctri] and [Alt] as their standard hotkeys.These can
be changed if they clash with other software or hardware within the installation (Ctrl +
Shift, Alt + Shift, .Right Alt, etc.).

e Default switching mode - Determines the standard switching mode to be used at
power on (All, KM + speaker, KM only, etc.).

* Mouse switching - You can enable or disable mouse switching to suit your
installation requirements.

* Options port mode - Determines how the serial Options port should function.
Choices are Serial control to received switching commands from a computer or RC4 (or
RC8) compatible for use with optional Adder remote controls.

e Options port speed - When the setting above is set to Serial control, this setting
allows you to choose the communication speed (/10 to 230400 baud).

* Port cycling - Determines which computer ports should be visited when the user
issues an instruction (either by mouse buttons or keyboard hotkeys + tab) to cycle to
the next port. Options are Cycle all ports (even those that are not active) or Cycle only
active ports.

* Audio mixing - Allows you to route the audio channels from any (or all) computers
to the user’s speakers, regardless of which computer is currently switched through to
the user console. This is useful for hearing alerts that may be sounded by computers.
Place a tick next to each computer whose audio you wish to route through to the
user console at all times.

Keep alive options
This feature is used to prevent selected computers from going into sleep mode by
emulating activity on the mouse/keyboard.Two modes are possible:

* On activity - When chosen, keep alive activities are sent every |5 seconds as long as
the local console is in use.When the local console is not in use then no keep alives are
sent.

e Always - When chosen, keep alive activities are sent continuously every |5 seconds.

Channels: Place a tick next to each computer that needs to be kept awake.

Switch identification

This section allows you to optionally apply Name, Description and Location details to the
CCS-PRO. For larger installations where multiple units exist, this information can be
very useful for identification purposes. Additionally, the Name entry is also used when
performing a DHCP search.

If the Name and Location entries are set, they will be displayed at the top of each CCS
Manager page as the Switch ID (replacing the MAC address).

ADDER
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Network settings
ADDER

To display the Network settings page The various network settings are as follows:

| Access the CCS Manager. * Require a username and password to logon - When ticked, the unit will request
2 On the left side, click the Configuration button. a valid username and password before allowing access to the CCS Manager.

3 On the left side, click the Network settings option. * Obtain IP address automatically (DHCP) - When ticked, the unit will derive

its IP address, netmask and gateway settings from the DHCP (Dynamic Host
Configuration Protocol) server on the local network.Additionally, the optional Name
entry entered within the General Configuration section can also be used when
performing a DHCP search.

CCS-PRO

14 J

INSTALLATION

e Address, Netmask and Gateway - When the setting above is unticked, these three
—— fields are used to define the fundamental network settings of the CCS-PRO unit.The
default settings are as follows:

e Address: 192.168.1.22
e Netmask: 255.255.255.0
* Gateway: 192.168.1.1

When the Obtain IP address... option is ticked, these three fields will display the
settings that were defined by the DHCP server.

CONFIGURATION

UPGRADE

FURTHER
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User accounts

To display the User accounts page Managing users e
| Access the CCS Manager. The maximum number of declared users is limited to an administrator and up to four
2 On the left side, click the Configuration button. other users.A list of current users will be shown and you can alter the list as follows:
3 On the left side, click the User accounts option. To edit a user
I Click on the user name. 5
2 Click the Edit user button. Lj_(
3 Adjust the Username and/or Password as required. ;

Note:The admin username cannot be changed.

DELETE USER

STATUS 4 Click the Save button.

To add a user cz)
Sl | Click the Add user button. -
<
- H o
e —— 2 Enter the required Username and/or Password. 3
3 Click the Save button. E
ADD USER )
To delete a user v
| Click on the user name.
TEErre 2 Click the Edit user button.
3 Click the Delete user button. z
Note:The admin user cannot be deleted. g
o
4 Click the Save button. HS
z
x
i
25
P
X
w
a
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Clipboard

To display the Clipboard page

| Access the CCS Manager.

2 On the left side, click the Configuration button.

3 On the left side, click the Clipboard option.

CCS-PRO

1

STATUS

Fa

UPGRADE

Enabling clipboard operation

In order to use the USB Clipboard utility to copy and paste data between connected
computers, the ports must be enabled individually. Before enabling a port, ensure that
the connected computer is accessed exclusively by a single operator, ie not connected
to multi-user or matrix KVM switches, where unintentional sharing of clipboard data is a
possibility:

To enable clipboard operation
| Click on each required port number to place a tick.

2 Click the Save button.
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Factory reset
ADDER

To display the Factory reset page Performing a factory reset

| Access the CCS Manager. A factory reset will return the CCS-PRO to its original configuration.All network

2 On the left side, click the Configuration button. settings will be reset (the default IP address of 192.168.1.22 will be restored) and all
users, except for the admin user will be removed. Additionally, if any Free-Flow layouts

3 On the left side, click the Factory reset option. )
are stored, they will also be removed from memory.

There are two ways to perform a factory reset:
CCs-PRO

* Within the Factory Reset page of the CCS Manager, or
J

INSTALLATION

* Using the front panel MODE button.

Both methods are discussed below.
STATUS
To perform a factory reset within CCS Manager

I Within the Factory Reset page, click the Factory reset button.

WARNING
The CCS-PRO unit will be returned to its standard state.

To perform a factory reset using the front panel MODE button
I Remove power from the CCS-PRO unit.

FACTORY RESET

CONFIGURATION

2 Press and hold the front panel MODE button and restore power.
The CCS-PRO unit will be returned to its standard state.

UPGRADE

FURTHER
INFORMATION OPERATION

INDEX
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Upgrade

ADDER
To display the Upgrade page Performing a firmware upgrade
Note: Firmware upgrades are not possible using the Safari browser, please use a different The CCS-PRO switch is fully upgradeable via a firmware upgrade.
browser when performing upgrades. Note; Once the CCS-PRO has entered upgrade mode the USB ports are disabled. It is not
| Access the CCS Manager. recommended to apply the upgrade from a computer connected to the CCS-PRO. If the upgrade
2 On the left side, click the Upgrade button. file is on @ memory stick connected to the CCS-PRO, The CCS-PRO will remain in this locked z
state, in order to recover you can connect to the webpage and perform the upgrade again. g
CCS-PRO | To perform a firmware upgrade e
Z

= I Download the latest CCS-PRO firmware upgrade file from the Adder Technology
website (www.adder.com) and install it on a computer that is attached via a network
connection to the CCS-PRO switch.

STATUS

The file is supplied as a compressed ZIP file. Decompress the ZIP file with an

z
CONFIGURATION Gurrent firmw 3 appropriate tool such as WinZip (www.winzip.com) and extract the contained *.bin file. g
2 Access the Upgrade page (as detailed left). °<D=
SELECT UPGRADE FILE 3 Click the Select upgrade file button and use the subsequent file dialog to locate 2
the downloaded *.bin upgrade file. Once selected, the name of the upgrade file will be 5
displayed within the Upgrade window. v
4 Click the Start upgrade button.As the process begins, the Upgrade page will show
‘Upgrade in progress’ and the CCS-PRO front panel will show ‘L".
The upgrade process may take several minutes to complete, after which time the CCS- g
PRO front panel will return to showing the current channel number. g
o
5
z
x O
Tg
z
&
o)
Z
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FREE-FLOW CONFIGURATION (Windows PC required)

ADDER’
Note:Whenever a factory reset is performed on a CCS-PRO unit, the Free Flow Configuration will
be deleted and need to be repeated.
Installing the standard configuration application Configuring a standard Free-Flow system
The Free-Flow configuration application is available for download from the Adder Use the Free-Flow application to declare the display screens and their positions relative
website (www.adder.com). to each other.Then download the configuration to the CCS-PRO switch. 5
=
| Install the application onto any computer (not necessarily one of the four computers I On the icon bar, click the red, green, blue and yellow screen icons (or use the Screens 3
linked to the CCS-PRO switch). menu) to add the required number of display screens to the map area: £
. . z
2 Connect the computer to the CCS-PRO via the network port. See To temporarily =
connect a computer to the network port for details.
3 Run the installation application and follow the on-screen instructions. Once installed,
start the Free-Flow application. It may report that it is ‘Unable to communicate with z
the device'. If so: E
g
a Click the OK button, whereupon the Free-Flow window will open. £
. . . L . )
b Select Configure > Connection... to display the Communications configuration "U T_IIE]D E
dialog. ° 9
c In the first tab, select the Network connection.The Serial option is used only for
the standard CCS4-USB switch: Note: By default, the Free-Flow screen will automatically add four screens in a straight row
; " (KEYRREIY 2R), each at a resolution of 1920 x 1080.You can edit or delete these screens
S e R . -
I st comectonype s ewoe| as required. 5
I Adess o hosname: 17768172 2 Arrange the cgloured rectangular screen representations to mimic the physical layout é
Usr Nrme: [ of the actual displays, for example: 5
Password: | 1A 3A m 1A
[ Use authentication 3A m 1A
N A
—_— The important thing is to define where each screen edge abuts to the next so that the o 5
d Enter the IP address of the CCS-PRO unit (it is set to 192.168.1.22 as standard) as CCS-PRO switch can determine the correct moments to switch channels. E g
. X 7
well as the username and password, if used. Use the small black squares around the perimeter of each highlighted screen 29
e If required, test the connection. Select Configure > Send Layout to Switch. If representation to change their size or stretch them. £
no error message is returned then you can assume the connection is working. Note: The numbering of the screen images relate directly to the four channels on the switch.
continued
i
a
Z
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3 Double-click on each screen representation to set the screen resolution and,

optionally, add a screen name and/or configure an LED monitor indicator: ADDER
CENEES )
Screen Information | LED Set-t.lpl
Screen Resolution
x. [1600 See also Additional Free- 5
Screen Name Flow operations and settings g
IMainscrben <_(I
;
Z
The screen resolutions are not critical but they enable the CCS-PRO switch to 5
accurately map the movement of the mouse onto corresponding movements of the g
. . o
pointer across the screens.The screen names, if used, are not downloaded to the 3
CCS-PRO switch. E
If you need to configure an LED monitor indicator, click the LED Setup tab. Please see 9
Configuring LED monitor indicators for details.
4 When the screen map is complete and accurately matches the true layout of the
display screens, choose File > Save to store a copy of the layout. The layout will be
stored as a ‘Free-Flow Config file’ with the extension: .ffc 3
5 To send the configuration, select Configure > Send Layout to Switch. g
w
* If the download is successful, the screen representations will briefly turn grey and 5
the upper four indicators on the CCS-PRO switch will begin to scroll across (they
will continue to do this while Free-Flow mode is enabled).
* If the download is unsuccessful,a message dialog will explain that it is ‘Unable to
communicate with the device’. Check the connection and the settings mentioned in .
the section Installing the standard configuration application. g O
I<
Ex
<
2
Z
x
w
a)
Z
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Multi-Monitor Free-Flow configuration (Windows only)

ADDER
Installing drivers and multi-monitor config app 1) Free-Flow Multi-Monitor Driver Setup
In order to use Multi-Monitor mode you will need to install a Multi-Monitor Free-Flow Sl
driver (available for download from the Adder website www.adder.com) onto each PC Select which feabures youwoukd ke o indel
that has multiple monitors attached.
I On each multiple monitor PC, run the downloaded file. After accepting the licence | | &~ i _ Adder Technology Free-Flow Z
. . . K - = - | Configuration App. Multi-Manitar Driver Installer. On o
agreement you will be prompted to choose a destination folder. Either accept the ' Visual C-++ 8.0 Runtime | this screen, you may remove g
. . =3~ Drivers features you do not wish to install. =
suggested location or change it, as necessary. z
(%]
z

Note:The Install for all users option should be ticked if there are more
Thig feature requires 0 KB on your

than one user account on the PC and all need to use Free-Flow. hard drive. Tthas 3 of 3

it# Free-Flow Multi-Monitor Driver Setu subfeatures selected. The
1 P subfeatures require 3945 KB on

your hard drive.

Change current destination folder

z
e to the destination folder (]
g
o
>
0
i
T Reset | < Back I Mext = I Cancel | %
v}
Ll
Choose the required components and click the Next > button.
Look in: 5 Multi-Monitor FreeFlow j ﬁl 2' £| q P
3 Once the chosen components have been installed, click the Finish button.
¥ Install for all users, . . . e
Note: On the PC that will be used to set up the CCS-PRO switch, you can optionally tick ‘Click z
" — | to run the Free-Flow Configuration Application’in the lower left corner to immediately begin >
< B Next > Cancel . . . . .
using Free-Flow - see Configuring multiple monitors on the next page for details. &
o}
. . L . nitor Driver Setup
2 The options available during installation are as follows:
° is i = ¥
Full Install, (this is recommended), or The Free-Flow Multi-Monitor
» Options to install individually: Driver has been successfully
e Configuration App installed. Z
o o . Click the Finish button to exit the Setup Wizard. x 2
This is the Free-Flow application and needs to be installed only on the PC that R i A O A B i
will be used to set up the CCS-PRO switch via the network port. . Coe k%
If the mouse iz frozen at this point, please press 20
e Visual C++ Runtime <hotkeys=F to release the mouse and reboot the PC. Z
The C++ runtime library is a windows component that is required by the Ta view the driver status, check the Human Interface
. . K . . . i K ! Devices” and "Mice and other Pointing Devices" sections in
multi-monitor driver in order to run its helper applications. It is pre-installed your computer’s Device Manager.
with Windows but is offered here as an option as you may want to keep an
older version already installed on your system, or you may already have a newer [Fr——
version in your copy of Windows. Ciick o run the Free-Fiow Configuration =
sion in your copy fp Gk s Carvguaien) y
* Drivers 2]
Multi-Monitor Free-Flow drivers that are required on each PC that will be using Note: On each PC that you installed the driver, a process called mumoapp.exe will remain
Multi-Monitor. running.
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Configuring multiple monitors

Multi-Monitor configuration is similar to normal Free-Flow setup except that you can

add more than one display per PC, up to a total of eight per machine.

Note: It is necessary to install a driver on each PC that has multiple displays - see Installing

drivers and multi-monitor config app on the previous page.

| If it is not already running, start the Free-Flow configuration application on the
computer that is connected to the network port of the CCS-PRO switch. See
Installing the standard configuration application for details.

2 On the icon bar; click the red, green, blue and yellow screen icons (or use the Screens
menu) to add the required number of display screens per computer to the map area.

For example, to add two monitors for PC I, click the red computer icon twice.The

two red monitor representations will be placed side by side within the Free-Flow map

area.

File Configure Screens Help

D5 o iy 9 28| 2

1A 1B

1600 x 1200 1600 x 1200
LED 1 (Blue) LED 2 (Blue)

3 Arrange the coloured rectangular screen representations to mimic the physical layout

of the actual displays. For example, you may wish to have the two screens of PCI side
by side, with the two screen screens of PC2 below them (as shown left), or some
other arrangement to reflect the actual positions of the physical monitor screens.

The important thing is to define where each screen edge abuts to the next so that the
CCS-PRO switch can determine the correct moments to switch channels.

Use the small black squares around the perimeter of each highlighted screen
representation to change their size or stretch them.

Note:The numbers of the screen representations relate directly to the four channels on
the CCS-PRO switch, while the letters relate to the screen hierarchy attached to any single
computer (i.e.A is primary, B is secondary, etc.).

[Optional step] If you need more squares on the grid in order to arrange many
displays in a row, right click on an empty square (or on the darker gray edging) to
enlarge the grid. Further right clicks will add even more empty squares.

5 Continue from step 3 of the standard Free-Flow configuration instructions.
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Configuring LED monitor indicators

When the optional CCS-XB LED monitor indicator kit is used, there are several 3 For a newly added screen the LED: entry will show No LED. Click on the drop ADDER
configuration options available that allow you to customise behaviour and these are set down handle and choose the LED indicator that you wish to associate with the
using the Free-Flow configuration application. currently selected video display screen:
Note that the LED monitor indicators may be used without Free-Flow.
Adjusting colour and brightness for all indicators Sereen Ifomation LED Setp | 5 QM 3 z
If necessary, you can impose default colour and brightness settings upon all connected E >U<’ 0 %E £
LED monitor indicators. Choose Configure > LEDs... to display the following popup: e 2 @ g 5 2
- - - [
LED Module.. [ Erne= 5 > 5 pa
N e - Z 5
%)
Default colour: IREd - -
B nl B
[ setall LEDs to this colour > 0 ©
r4 _ z
Default brightness: 0 5 ; 5 o
0 g
= o
f = 2
R g 9
- . S z
Each entry within the LED: list relates to one of i o g
-_— the ten output sockets on the CCS-XB module. ] § = 5 0
Toi default colour on all connected indicators, choose the required Default ; ; ; e °
O Impose a ’ q Note: It is possible to associate any LED
colour and then tick the option Set all LEDs to this colour. indicator with more than one video screen.
Use the Default brightness option to determine the intensity of all indicators. 4 Choose the CCS-XB LED output port that you wish to associate with the currently }
Click OK to exit and apply the required settings. selected video screen. o
=
. - - . . . . o <
Note: Once default settings have been made you can optionally change any or all indicators 5 Optionally alter the colour, from the Colour: list, that you wish the LED indicator to P
individually as required using the steps outlined below. display when the associated video screen is selected: )
Adjusting individual indicators [
For each installed video display screen, you have the opportunity to add and configure an | Note:Each LED indicator can only
LED monitor indicator Screen Information  LED Setup | | have one colour, so if you associate an
. . R . LED: [cED# indicator with more than one screen
To adjust details for an individual indicator P
) . ) . ) and then change the colour on a later x O
| Double-click on a screen representation (or right click on a screen representation and Red . i+ will be ch d g
hen choose Properties) to display the screen popu Blue screen assignment, it will b change EZ
¢ P play popup- Green for all the screens in the list for that 20
2 Click the LED Set-up tab to display the indicator details: A LED indicator. z
Screen Information  LED Set-up
omation I ,TI
LED: No LED
Coour:  [Bue Click OK to save and exit. E
Repeat steps | to 6 for each screen that requires an LED monitor indicator. z

Choose Configure > Send Layout to Switch to update the CCS-PRO switch.

O 00 N o

The LED monitor indicators may be used without Free-Flow.To disable Free-Flow,
simultaneously press and hold Ctrl and Alt, then press FEThis acts as a toggle, so repeat
to re-enable Free-Flow.
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Additional Free-Flow operations and settings
In addition to the core configuration functions, Free-Flow has a number of additional
settings that you can make.

Mouse... (acceleration) setting

Acceleration:

fi§

25 50

o]

Cancel |

Acceleration

Mouse acceleration allows you to move the mouse pointer quickly across the large areas
of the screen in response to small but sharp shifts in the mouse position.The Configure
> Mouse... option provides settings between 0 and 50, however; a value of 12 to 15 will

give a typical Windows-like default operation.

Mouse parking... setting
' |

P )

Use the scroll bars to set the
location For the mouse when
it is moved off-screen.

I

J 100

Cancel I

Mouse parking allows you to optionally determine where the mouse pointer for each
system should be placed when the focus moves to a different system/video screen.The
Configure > Mouse parking... option displays vertical and horizontal scroll bars. Use
the scroll bars to pinpoint the position that should be used to park the dormant mouse
on each screen.

Switch... settings

[ o 1]

Cancel

[V Enable Free-Flow.
Start-up Port: I 1 vl

Switch Mode:
¥ Keyboard | Mouse [ usB1
™ Audio [~ usez

Enable (Disable) Free-Flow

This option allows you to switch off the Free-Flow feature within the CCS-PRO switch.
Located within Configure > Switch... menu item, untick the Enable Free-Flow
checkbox and download the configuration the CCS-PRO switch to disable.

Start-up Port

Located within Configure > Switch... menu item (see above image), this option allows
you to determine which port should be enabled whenever the CCS-PRO switch is first
powered on.

Switch Mode

Located within Configure > Switch... menu item (see above image), these check boxes
allow you to determine which peripherals should be switched whenever the channel is
changed by the Free-Flow method. The switching of peripherals via the other methods of
channels selection (e.g. the front panel, hotkeys, mouse buttons, etc.) remain unaffected
by these settings. By default, the Keyboard/Mouse and Audio are selected.

ADDER’
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INSTALLING AND CONFIGURING THE USB CLIPBOARD UTILITY

Prerequisites
* The Clipboard utility is required to allow cut, copy and paste functions between
computers.

* The Clipboard utility is supported on the following operating systems:Windows 7, 8
and 10.

* Each system connected to the CCS-PRO switch requires the Adder Clipboard utility
to be installed and activated.

* Each system also requires the Microsoft .NET Framework (v4.0 or above) to be
installed. This is available for free download from Microsoft.

* The CCS-PRO switch needs to be configured to enable transfer of clipboard data.
Refer to CCS Manager on page 21.

* Only text (formatted or otherwise) can be transferred between systems, to a
maximum size of 200KB.

Security

As text is transferred between the systems attached to the CCS-PRO switch, security

is an issue which needs to be addressed. The USB Clipboard application provides the
option to encrypt all information. Unless the whole CCS-PRO installation is operating
within a secure environment, you are strongly recommended to accept the use of
encryption.VWhen enabled, you will be given the choice of using a default encryption key
or creating a custom one, which must be the same on every system.When creating your
own encryption key, we recommend that it is a minimum of 8 characters, consisting of

mixed upper and lower case letters plus at least one number and also a special character.

Installation and configuration
* The USB Clipboard installer is available for download directly from Adder Technology
(www.adder.com).

On each computer attached to the CCS-PRO switch:
| Ensure that you have Administrator privilege, then run the ‘Install USB Clipboard’ file.

2 In the opening dialog, click the Install button. Follow the on-screen prompts as the
installation progresses.

3 At the end of the installation process, you will need to configure the application.
Either, ensure that the ‘Configure USB Clipboard Now’ option is ticked on the final
installation page, or finish the installation and then search within the Windows Start
menu for ‘USBC-Config’.

4 The initial option within the
configuration utility relates
to the important subject of
security:

[8) USB Clipboard Configuration — O *

whether and how to encrypt the copied data

* Choose the ‘Use
Encryption’ option unless
the whole installation is
fully secure. See Security
on the left.

® No encryption
Data will be transferred unchanged.
Any PC connected to the switch will be able to receive the clipboard.
This is insecure.

(0 Use Encryption.

Data will be encrypted and decrypted using the same key on all the PCs.

5 Click Next to continue. o e e o e

Next Cancel

6 If the ‘Use Encryption’
option was chosen, the next
page WI” concern the use Set Password for Encryption or use Default Encryption Kay.
of encryption passwords.

[ USB Clipboard Configuration - O X

Encryption Key Configuration Page

The same password needs Enter Pssword
to be used on each system &L=
connected to the switch. ConfimPassword @ Custom

Choose the option that suits
your installation. See Security
on the left.

Mote:USB Clipboard Application will encrypt data using secret Key
Password should be same on all FCs

Back Next Cancel
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7 Click Next to continue. Using USB Clipboard
The Options page will be displayed: For details about using the USB Clipboard function,
see page 35.

ADDER

|5 UsB Clipboard Configuration = ] X

_ Maxi copy size

The USB clipboard copier will perfform any copy up to the maximum without user
confirmation. An attempt to copy more data will require the user to click the
overside button in the copier status window

As of now only 200K is supported

INSTALLATION

[[] Show notfications g
O ?:%’;?E“THF ;llung with Ted pote: This will reduce amount of text being shared. E
: o
]
= == 5
[’
z
(0]
8 Here you can: Y]
e Determine the maximum copy size (currently fixed at 200KB).
* Choose to show notifications - if selected, USB Clipboard will show any necessary messages, (such as
when text is sent or received, or the clipboard capacity is being exceeded), as push notifications. >
. . . ) . . o
* Choose to include formatting along with text - if selected, formatting data (such as HTML or RTF) will >
be transferred across the clipboard to receiving systems.The necessary formatting data will form part &
of the 200KB maximum and will reduce the space available for text. 0
9 Click Next to continue.
A summary page will be displayed:
[54] USB Clipboard Configuration - m} X
z
o O
Confirm'to configure the USB Clipboard uIJ ;<—(
Ex
4
20
Encryption mode |U5e Encryption. | %
Maximum copy size |ZDO kBytes |
Show notifications? |No |
Include text formatting? |No |
This PC's key: |DefauItKey |
x
w
a
4
Back Cancel

10 If all is correct, click Confirm to continue, otherwise use the Back button to return to previous pages.
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Operation

SELECTING A COMPUTER

There are six ways to switch the common peripherals to specific computer channels:
¢ Using the innovative Free-Flow automatic switching utility )

¢ Using the control panel @

* Using hotkeys

* Using mouse button presses

* Remote control via an external system
* Using the optional RC4 remote control

Selecting a computer using the Free-Flow utility

Once configured, Free-Flow allows you to change channels merely by moving the mouse
to edge of one screen towards the next screen.As the mouse pointer reaches the edge
it will cause the channel to automatically change and will jump to the next screen.

Notes:

* Free-Flow cannot be enabled until a layout has been configured and downloaded to the CCS-

PRO switch - see Free-Flow configuration.
* The mouse will not flow across the screens while any mouse buttons are pressed down - this
prevents undesired behaviour when dragging windows around or group-selecting items.

* You can determine which peripherals will be switched by Free-Flow independently of those
that would be switched with any other method. See Switch Mode within the Switch...
settings section.

* You can continue to use any of the other channel switching methods while Free-Flow is
enabled.

The four upper indicators on the CCS-PRO display panel will scroll across every few
seconds to show that Free-Flow is enabled. See What is Free-Flow? for an introduction
to the utility or Free-Flow configuration for more details about how to prepare it for
operation.

You can temporarily disable (and re-enable) Free-Flow using hotkey presses:
+ Simultaneously press and hold and @, then press [FJ

Selecting a computer using the control panel

The control panel allows you to determine how the various peripherals are switched to

one or more computer channels.
Indicates the number

of the currently
selected computer

The upper K/M, SPK, USBI, and USB2 indicators show which
peripherals are switched to the current computer channel OR (as
you begin pressing the MODE button) the peripherals that will be
switched during the next press(es) of the COMPUTER button.

Use this button to COMPUTER KiM  SPK USBI 1,SB2 Use this button
choose the next to choose which
required computer '_‘ ® o 00 peripherals will

be switched

The lower four indicators will
intermittently scroll across
whenever Free-Flow is enabled.

| Optional: If you need to selectively switch some of your peripherals, press the MODE
button repeatedly to change the switching mode:

K/M  SPK USBI USB2
MODE ‘ . . . Will switch all peripherals together
o

MODE . . Will switch keyboard, mouse and speakers
Bt
MODE . Will switch only the keyboard and mouse
LBt
MODE . Will switch only the speakers
H—y
MODE . Will switch only USB peripheral |
Bt

. Will switch only USB peripheral 2
Notes:

* If an indicator flashes, it signifies that the respective peripheral is currently switched to
another computer channel.

* The peripherals to be switched using the Free-Flow method are set independently.

2 Press the COMPUTER button repeatedly to select the required computer channel.
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Selecting a computer using hotkeys
Using hotkey combinations, you can quickly switch the keyboard and mouse, speakers
and USB peripherals to any computer channel.

To select a computer using hotkeys
The standard hotkey press combinations allow you to change channels with the minimum
of keypresses:

| Simultaneously press and hold [Ctrl] and [Alt] (or other hotkeys, if altered).

2 While still holding and [Alt], press the number key of the required channel address
(or the TAB key), then release all of the keys.

Note:The numbers on your keyboard’s numeric keypad are not valid, use only the numeral
keys above the QWERTY section.

The ports (K/M, audio and/or USB) that are switched using this method depend upon
the switching mode that is currently set using the control panel buttons.

The range of standard hotkey combinations are as follows:

Note: If your hotkeys have been changed, substitute them for and [AlY in the examples
given here.

ctri] A Selects channel |

Ctrl] Selects channel 2

ctril Selects channel 3

ctrl) (At 4]  Selects channel 4

ctrl] (A Selects channel 5

ctril [6] Selects channel 6

Ctrlf Selects channel 7

Ctrlf Selects channel 8

[ctr) [At) [0]  Isolates the user console from all channels
Selects the next channel (see note =)

CCS-PRO8 models only

What are hotkeys?

The and keys when pressed in combination are called ‘hotkeys’ and they
signal to the CCS-PRO switch that you wish to control it, rather than the computer.
However, if these particular hotkeys clash with another device or program, you can
change them to a different combination within the General configuration page of the
CCS Manager.

To disable/enable Free-Flow

Once Free-Flow is in operation, you can temporarily disable (and re-enable) it.You can
tell when Free-Flow is in operation when the four lower indicators on the CCS-PRO
front panel scroll across every few seconds.

 Simultaneously press and hold and (Al then press

Choosing which computers are accessed when using hot keys + tab
The computer channels that are visited when you use the hot keys + tab (or mouse
buttons) are determined by a setting within the Configuration menu:

| Enter the General configuration page of the CCS Manager.
2 Choose the required Port cycling option, either:

e Cycle all ports (visits even inactive ports), or

* Cycle only active ports.
3 Click the Save button.
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Selecting a computer using the mouse buttons

Using the mouse buttons, you can quickly switch the keyboard and mouse, speakers and/
or USB peripherals to any computer channel.

Note:These procedures work only with three-button or IntelliMouse devices and only if the
‘Mouse switching’ option has been enabled (within the General configuration page of the CCS
Manager).

To select a computer using the mouse buttons
| Hold down the middle button (or scroll wheel) of the mouse.

2 Click the left mouse button to increment the channel number or click the right mouse
button to decrement the channel.When the correct channel is reached, release the
middle button.

When using this method of switching:

* The computer channels that are visited depend upon the configuration menu
setting (see note ).

* The ports (K/M, audio and/or USB) that are switched using this method depend
upon the switching mode that is currently set using the control panel buttons.

Choosing which computers are accessed when using mouse buttons
The computer channels that are visited when you use the hot keys + tab (or mouse
buttons) are determined by a setting within the Configuration menu:

| Enter the General configuration page of the CCS Manager.
2 Choose the required Port cycling option, either:

e Cycle all ports (visits even inactive ports), or

e Cycle only active ports.
3 Click the Save button.

ADDER’

FURTHER
INFORMATION OPERATION CONFIGURATION INSTALLATION

INDEX

34




USING COPY AND PASTE
USB Clipboard is an optional utility which allows text to be copied and pasted between
any of the connected systems. For installation details, see page 30.

Startup
During installation the USB Clipboard utility is added to the Windows System Tray and
will be started automatically at every reboot.

You will see this icon in the System Tray:
e

If the USB Clipboard utility is not already running on a system, activate it using the
Desktop shortcut ‘Start USB Clipboard’.

Notes:

* The systems should be connected to the CCS-PRO switch before starting the USB Clipboard
application.A warning message will be displayed if the CCS-PRO switch cannot be located.

* If the CCS-PRO switch is disconnected and reconnected on same port, the USB Clipboard
utility will detect it automatically. If reconnected on different port then USB Clipboard utility
will need to be restarted.

Sharing text via the USB Clipboard

The USB Clipboard is transparent in operation and essentially operates in the same way
as a standard copy/paste procedure on any Windows system.When the USB Clipboard
utility is running, any normal copy and paste action (of text) will be mirrored in the
background by the utility.

To cut/copy text

* On your chosen source computer, highlight the required text within any application
and use either the menu option ‘Edit > Cut’ (or ‘Edit > Copy’), or use the keyboard
shortcut ‘Ctrl’ + X’ (or ‘Ctrl’ + ‘C’) to save a copy into the clipboard.

To paste text

* On your chosen destination computer, place the cursor at the required location and
use either menu option ‘Edit > Paste’ or use the keyboard shortcut ‘Ctrl’ +‘V’ to paste
the clipboard contents.

Notes:

* Status messages detailing the clipboard contents and operations will be displayed if the ‘Show
notifications’ option is ticked within the configuration utility.

* HTML or RTF text formatting is transferable via the USB Clipboard. Ensure that the ‘Include
text formatting’ option is ticked within the configuration utility.

Warning and error icons
The utility will show status icons within the System Tray if issues are detected:

al) device is not found, copy size is detected, such as a failure to
is larger than limit, etc. send or receive data.

=(\ Warning - Displayed if a @,@ Error - Displayed if a fatal error
%..,

Modify configuration
You can modify various operational details of the USB Clipboard utility on any of the
connected systems.

To modify configuration
| Display the configuration window, either:

* Show the Windows System Tray: Click the * icon on the Windows taskbar and then
click USB Clipboard icon to show a popup menu. Choose the ‘Configure’ option
from the popup menu.

¢ Click the Windows Start menu, then locate and run the ‘USBC-Config’ option.

2 Make the required changes within the configuration window and click the Save button.
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Further information

This chapter contains a variety of information, including the following:
* Getting assistance - see right

e Troubleshooting

* Appendix | - Cable pin-outs

* Appendix 2 - What is True Emulation?

LITHIUM BATTERY
CAUTION:This product contains a lithium battery which must be disposed
of in the correct manner.

CAUTION: RISK OF EXPLOSION IF BATTERY IS REPLACED BY AN INCORRECT
TYPE.

* If the lithium battery needs to be changed, you must return the product to your
nearest Adder dealer. The battery must be replaced by an authorized Adder dealer.

* Once the product has come to the end of its useful life, the lithium battery must be
removed as part of the decommissioning process and recycled in strict accordance
with the regulations stipulated by your local authority. Advice on battery removal can
be provided on request by Adder.

GETTING ASSISTANCE

If you are still experiencing problems after checking the information contained within this
guide, then please refer to the Support section of our website:

www.adder.com
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TROUBLESHOOTING

Problem: My computer and the CCS-PRO switch are connected to the same
network but | can’t make contact using a web browser.

There may be another device using the same address as the CCS-PRO default
(192.168.1.22) or your computer may be on a different subnet.

Remedies:
* Check whether any other device on your immediate network is using the same
address and temporarily disconnect it, if possible.

* Make a temporary direct connection between your computer and the switch in order
to change the IP address used by the switch.

* Check that your computer and the switch are on the same subnet. If necessary, change
your computer’s subnet mask setting to encompass that of the switch, e.g. instead of
255.255.255.0, try 255.255.0.0.
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APPENDIX | - CABLE PIN-OUTS

The OPTIONS port uses a 10p10c socket which can accommodate both 10p10c ADDER
connectors as well as the much more common 8p8c connectors, which are used on
Ethernet leads and patch cables. The pin-outs are listed in this section for both types of
connector.
5
Serial remote control cable (8p8c) E
8p8c D-Type female E
connector 9 way 4
™o ® @ RXD
RXD @ ® TXD ;
GND @ ® GN\D £
5
9
Serial remote control cable (10p10c) §
10pl0c D-Type female
connector 9 way
™d @ @ RXD z
RXD @ ® TXD <
GND O ® GND ©

Note:You can also use the optional serial cable (part number VSC40).
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APPENDIX 2 -WHAT ISTRUE EMULATION?

True Emulation represents a significant breakthrough in sharing USB devices between
two or more computer systems. Until this point, the problem has been how to create a
USB switch that provides all of the following:

* Quick, transparent and reliable switching,
* Accurate representation of the connected USB keyboard and mouse,
* Switching control via the connected USB keyboard and/or mouse.

The difficulty in achieving all of the above requirements has been due to the complexity
of the USB standard.This has led to various problems that have spawned a number of
possible solutions.

Enumerated USB switching

The earliest attempts to switch USB devices applied a relatively ‘hands off’ approach.
Enumerated USB switches are the electronic equivalent of those old mechanical KVM
switches with a large knob on the front.

Enumerated switches are so called because a connected USB device will be required to
perform a full initiation (a process called Enumeration) every time it is switched; just as if
you had pulled out the plug and then reconnected it.

Enumerated switches simply pass all signals straight through between the USB device and
the computer, they do not attempt to interpret any data. For most devices, this offers

an advantage because the switch just leaves them to get on with their jobs without any
interference or any hit on performance. However, it means that a USB keyboard or
mouse cannot be used to control the switching process - a quick and simple control
method expected by most users. Reliability of switching is also an issue that has plagued
enumerated switches, especially when used with certain USB devices and particular
operating systems.

Emulated USB switching

The issues with interpreting the complex USB data streams and recreating (or Emulating)
the identity of attached USB devices were eventually solved, leading to the creation of
the Emulated USB switch.

A neat side effect of the technique used is that each computer can be fooled into
thinking that the USB device is permanently connected to it, even when the device is
switched to another computer. This means that the enumeration process for the USB
device takes place only once, during the first power on.After that,a computer merely
sees a dormant version of the USB device whenever the device is actually connected to a
different computer.

However, it remains a complex task to dynamically assume the identity of a USB device,
distribute it among the connected computers and maintain all of the necessary signals,
states and processes. Therefore, manufacturers have previously relied upon a fixed
keyboard and mouse profile that is declared to each computer, regardless of the actual
connected devices.This precluded the use of any special keyboard or mouse features
over and above the standard layouts.

True Emulation

Mindful of the limitations associated with the previous
USB switching techniques, we set about creating a

more effective and elegant solution. After a great deal of
research and development, True Emulation is the result.

OTHER USB
DEVICE

HOST
CONTROLLER

True Emulation allows the complete identity of the
keyboard and mouse to be copied and then presented
to all of the connected computers.This means that
any keyboard offering specialist function keys or any EMULATION =
mouse with extra features will be fully supported at ENGINE
each computer.As with the previous emulation method,
the unselected computers will continue to see the
identities of the keyboard and mouse, which means that

no enumeration is necessary when their link becomes USE USB USB USB

PR S S S

active once again. This not only helps to speed up the HUB HUB HUB HUB
rate of re-connection, but also raises the reliability
of switching because USB links are at their most

vulnerable during the enumeration process. 1 2 3 4

True Emulation relies upon a high speed circuit, called
an Emulation Engine, to fully emulate the USB device
identities and also interpret keyboard and mouse data
streams. The result is full support for K/M switching
control via hotkey presses or the third button/scroll
wheel of a mouse.

The emulated section of the
switch is shown in blue and
handles only the keyboard and
mouse. The green enumerated
section of the switch handles
other USB devices and also uses
the USB hubs to link with the
computers.

True Emulation is not necessarily required by other
USB devices, which is why you will also find two
enumerated circuits included (shown in green within
the block diagram) alongside the True Emulation feature
(shown in blue).This allows those other USB devices to operate at their highest speeds,
without any intervention. The enumerated circuits benefit greatly from the USB Hubs
that are jointly used with the True Emulation system. Because they interface directly and
permanently with each computer, they help to stabilise the dormant links, making errors
during enumeration much less likely.

The dual switching arrangement provides further flexibility because the True Emulation
and enumerated sections can be switched in unison or independently of each other, as
required.Thus, your various peripherals can operate with different computers at the
same time. Please see software release notes for a list of supported products.
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APPENDIX 3 - OPEN SOURCE LICENCES

This product includes binaries that are derived from the open source community.

IwlIP is licenced under the BSD licence:
Copyright (c) 2001-2004 Swedish Institute of Computer Science.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

| Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3 The name of the author may not be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR “AS IS” AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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